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Entorno Vivado - Caracteristicas

» Diseino y analisis interactivo
— Analisis de temporizacion, de conectividad,
utilizacion de recursos, y restricciones de
temporizacion.
» Desarrollo a nivel RTL
— Generacion de codigo HDL
— Esquemas jerarquicos
— Generacion de diagramas esquematicos

» Integracién con el simulador XSIM
» Procesos de sintesis e
implementacion

» Gestion de ubicacion de I/O

— Asignacion de I/O basada en reglas
(interfase a memorias)
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Opciones de visualizacion del diseno

> Se puede generar una vista visual en las distintas etapas del ciclo de desarrollo
— Analisis en vistas netlist/diagrama/RTL
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Herramientas para alcanzar restricciones de temporizacion

» Se pueden analizar distintas implementaciones

— Resaltado de los caminos que no cumplen restricciones en un analisis
post-ruteo

— ldentificacidn de los caminos criticos para la temporizacion

» Planificacion de ubicacion fisica

— Ubicacion y ruteo guiados

» Utilizacion de estimaciones
— Estimacion de recursos
— Estimacion de area y tiempos
» Conectividad

— 1/Os utilizados, redes representativas de los circuitos l6gicos, dominios de
reloj, etc




Consola y Lenguaje Tcl

» TCL (Tool Command Languaje) es un lenguaje de scripting
interpretado. Su caracteristica principal es que todas sus facilidades
(estructuras de control, asignacion de variables, etc) tienden a la
forma de un comando (command Arg0 Arg1 ... ArgN)

» La consola Tcl permite interactuar con las herramientas del Entorno

> El uso de scripts se puede aplicar tanto a desarrollos centrados en
un proyecto, como a desarrollos independientes.

>» Los archivos de Journal y Logs se pueden utilizar como parte de los
scripts



Desarrollos basados en Proyectos y desarrollos independientes

» Las herramientas de Vivado pueden trabajar de 2 modos
— Desarrollos basados en Proyectos

. ) Project-Based Non-Project Batch
— Desarrollos independientes e
_ _ IDE script \ (  Script
» Desarrollos independientes — :
— No tiene estructura de proyecto psta prOTEEE: ST

@ Praject Satting: add files .. read vhdl ..
s import files .. read edif ..

— Basados en scripts Tcl Sriiw
— Se puede usar interface grafica (comando start_gui)

— Los reportes y puntos de chequeo deben generarse manualmente
mediante comandos TCL

laonch run synth 1 synth design ..
wait on run .. report timing summary
OpEN_Tun .. write checkpoint ..
report_timing summ opt_design
ary place design
laonch runs impl 1 report timing summary
wait on run .. write checkpoint ..
open ruon .. roote design
report_timing summary
write checkpoint ..

— Util para tests de regresion

» Desarrollos basados en Proyectos
— Estructura de proyecto (archivo *.XPR)

— Los Reportes/Estados/Iteraciones disponibles en cada punto del
ciclo de desarrollo

— Gestidon mediante GUI o scripts Tcl
— Util para nuevos desarrollos

'\ J
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Ciclo de disefo con Vivado

Agregado de IP en forma interactiva

System Planning and © Specificaion > ““‘d‘;;?;sm;“ 1?}'“**
—AXl4, IP_XACT, etc HDL Design ! e
Veriog (vHDL " PEoa0HOL

System Verilog

Un uUnico lenguaje de restricciones aplicable a
todas las etapas del ciclo de desarrollo (XDC)

— Permite aplicar restricciones en forma dinamica en Netlist Linking and
. Constraints
cualquier etapa

RTL Synthesis

: Packing, P! t
Reportes en cualquier etapa del desarrollo obinaen.

— A través de la API de reportes de Tcl

Routing_, Ffost_—Route
Un modelo de datos unico a través de todo el Optimization

ciclo de desarrollo Static Timing
Analysis

Se pueden salvar puntos de chequeo en
cualquier etapa

— Se mantienen los resultados de Netlist, restricciones,
ubicacion y ruteo

DRC and Bitstream
Generation

Silicon



Disenno centrado en una base de datos

Synthesis ]
| N

» Todas las herramientas acceden a
la misma informacién del proyecto
— Cada herramienta opera sobre una
netlist y la modifica o crea una nueva

> La netlist pasa por diferentes
estados durante el proceso de
diseio
— Elaborated
— Synthesized
— Implemented

[ Netlist Optimization ]\

!

[ Power Optimization ]‘f“’ﬂ?
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[ Placer W 7

! .

[ Physical Optimization ]
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[ Router ]

AT
b

Vivado Design
Suite
Database




Netlist:
» Una Netlist es una descripcién del sistema
que se esta disenando | Metlist _ i
— Consiste en celdas, pines, puertos y redes que los | & =&
interconectan (14 system _rapper = |
. . . & Mets (172]
— Las celdas son los objetos basicos del diseno B bins_Shits_tri_i {5) ‘
_ _ _ (- bkns_Shits_kri i IBUF (5) —
* Instancias de modulos (verilog) o entidades (vhdl) I DDR_addr (15) |
creadas por el usuario eI DDR ba (3)
G DOR_dm (4)
* Instancias de elementos de librerias B DDR_dq (32)
_ LUTSs, FF, RAMS, bloques DSP, etc... i#-d DDR_dgs_n (<)
] ) -1 DDR _dgs_p (4)
* Representaciones de funciones de hardware G-JF FIXED_IO_mio (54
. k-7 leds_shits_tri_o (&)
* Cajas negras I leds_sbits_tri_o_OBUF (%) o |
— Los Pines son puntos de conexiones de las celdas. g B svis Bt LG =

e

. . ources ;'] Netlist
— Los Puertos son la interfase de entrada y salida del : .

disefio.
— Las redes son conexiones entre los pines y entre los
pines y los puertos



Objetos de la Netlist
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Diseio en estado Elaborado (Elaborated)

» Representacion del diseio antes de la sintesis
— Netlist interconectada con una estructura jerarquica y generica de celdas

* Instancias de modulos/entidades
» Representaciones genéricas de componentes de hardware
— Compuertas AND, OR, buffers, multiplexores, sumadores, comparadores, etc...
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Nombres de los Objetos:

39 reqg .:_ L It;
> Los nombres de los Objetos se obtienen del RTL e
. . . (42 always Biposedge glk dsc)
— Los nombres de Instancias y Pines de Objetos 43 begin
. . . . ~ , . da i {E!‘[ulﬂst]
— Flip-flops inferidos de los registros/sefales/I6gica 45 begin
. 46 51@1&1‘.!& afd= 1'hi:
» Se agrega el sufijo _reg 47 signal dstf <= 1'b0;
. ~ 4 - . 4& mﬂ
— Las redes de los registros/sefales/Iégica cuando es apropiado & et .
1] begin
51 signal mets <= signal srec:
52 signal gzt <= Fignal meTA;
|53 end S/ 1f zar
54 end nl ey
meta_harden_rst_i0 )
= /
clk 1
96 ueza_h&rder(meta_h&rdfn_rsl;_iﬂ rst_dst signal_meta_reg signal_dst TEQ)
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95 .rae_fse {1'b0y), D o
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Disefio en estado Sintetizado (Synthesized)

» Representacion del diseiio despues de la sintesis

— Netlist interconectada de elementos basicos (Basic Elements — BELS)

* |Instancias de modulos/entidades

* BELs
— LUTs, flip-flops, carry chain, MUXes
— Block RAMs, bloques DSP
— Elementos de temporizacion (BUFG, BUFR, MMCM, ...)
— Elementos de 1/0O (IBUF, OBUF, I/O flip-flops)

» Los nombres de Objetos son los mismos que la netlist "Elaborated" cuando es

posible
| e | £
[mm-u %n indarpd 3 m
1
a FOCE
. -
— s
LUTG f 3T bewsd_ w16 en peg reg
4]
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Disefio en estado Implementado (Implemented)

> Representacion del disenio durante y despues del proceso de implementacion

— Estructuralmente similar al diseno sintetizado
— Las celdas tienen ubicacion definida y las redes se mapean al ruteo especifico del dispositivo
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Estructura de un Proyecto

» Toda la informacién del proyecto esta almacenada en un directorio con el nombre
del proyecto (project_name directory) conteniendo los siguientes subdirectorios:
— project_name.xpr : Archivo de configuracion del proyecto
— project_name.runs: Directorio con los resultados de las iteraciones de las herramientas
— project_name.srcs : Directorio con los archivos fuente HDL, netlists, y restricciones XDC
— project_name.data: Directorio con la informacidn de ubicacion en el dispositivo
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Archivos de Journal y Log

» Archivo de Journal (vivado.jou)
— Contiene los comandos Tcl ejecutados por el IDE

>» Archivo Log (vivado.log)
— Contiene todos los mensajes producidos por el IDE, incluyendo los comandos Tcl y sus
resultados, mensajes de info/advertencial/error, etc.
» Ubicacion de los archivos

— Linux: el directorio desde donde se invoca el IDE

— Windows invocado a través del icono: %APPDATA%\Xilinx\Vivado o
C:\Users\<user_name>\AppData\Roaming\Xilinx\Vivado

—Windows invocado a través de la linea de comandos: el direcotrio desde donde se invoca el IDE

— Desde la interface grafica (GUI)
» Select File > Open Log File
» Select File > Open Journal File
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Puntos de chequeo (Checkpoints)

» Guarda la base de datos a disco
— Netlist (edif, eventualmente una netlist verilog)
— Restricciones (xdc)
— Informacidn de ubicacion/ruteo/configuracion (xdef)

» Comandos Tcl

—write_checkpoint <filename>
» Genera un archivo filename.dcp, que es un archivo comprimido
» Se puede descomprimir a los archivos filename.edf, filename.xdc, filename.xdef, filename.wdf, y dcp.xml

—read_checkpoint <filename>

> Se pueden leer y escribir desde el IDE

> Se pueden abrir y modificar los checkpoints desde el IDE
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I a4
Pantalla de Inicio

Fie Flow Took Window Hep Q- Search commands

Todos los botones estan agrupados por
funcionalidad

Inicio Rapido
— Abrir proyectos anteriores
— Crear proyectos nuevos o de ejemplo

Tareas

— Gestion de IP, gestion de hardware,
repositorio de scripts Tcl (Tcl store)

Enlaces

— Documentacion y Tutoriales

—Videos

— Release Notes

Consola Tcl

VIVADO!

HLx Editions

Quick Start

& B

Create New Project Open Project

Tasks

Managt
Information Center

9 B

Documentation and Tutorials

A \rjsi
e 1P Open Hardware Manager

Quick Take Videos

Open Example Project

Release Notes Guide

E

@PH=THH
E




Asistente para nuevos proyectos (New Project Creation Wizard)

> Al crear un proyecto nuevo hay 5
opciones:
—RTL
* Es el mas genérico.
— Post-synthesis

* Los archivos fuente estan en formato EDIF
o NGC

—1/O planning
» Para ubicacion de pines de I/O
* No tiene archivos fuente

— Import Project

 Importar un proyecto desde Synplify, XST, o
ISE

— Example Project
 Crear un proyecto de ejemplo

Y P— gy

=] L | p DI
@ INEW FTQjecL

Project Type
Specifyr the type of project to create.

@ ETLProject

" You will be able to add sources, create block designs in IP Integrator, generate IP, run RTL

analysis, synthesis, implementation, design planning and analysis.

[ ] Do not specify sources at this time

(7 Post-synthesis Project: You will be able to add sources, view device resaurces, run design

analysis, planning and implementation.

Do not specify sources at this time

(7) L0 Planning Project

Do not specify design sources. You will be able to view part/package resources.

 Imported Project
Create a Vivado project from a Synplify, XST or ISE Project File.




Creacién de un proyecto (RTL/Synthesized Design)

Definir el nombre y ubicacién del
proyecto

Seleccionar los archivos fuente
— Se puede agregar cédigo Verilog o VHDL

Seleccionar netlists sintetizadas

Seleccionar archivo de restricciones

— Puede haber mas de un archivo y/o un archivo
especifico para las IP presintetizadas

Seleccionar el dispositivo o placa

Referenciar los archivos originales o
importarlos y copiarlos al proyecto

4 New Project

-
Project Type

saecrfy the ype of aroject 1o Creats. '

@ BTL Preject
"~ You will be able to add scurzes, croate block dosigns in IP Integrator, genarate TP, run RTL
analysis, synthesis, implementation, design planning and anayss.

|:| Do not sp=cify sources at this sime
=) Post-synthesis Project: You will be abls to adc sources, view device resources, run design
" analysis, planning and molementation.
Da not sp=cify sources at this ime
=) /0 Planning Project
~ Do not specify design sources. Yeu will bz able to view part/package resources.

) Imported Project
' Create a Vivado project from a Synalify, XST or ISE Project File.

(7) Exanple Projed
~  Cr2ate a rew Vivado projec: from z precefned template.

< Back ||

Next > 4

Finish [ Cancel ]

4 New Project

Default Part

Choose a default X part or board for your project, This can be changed later, '

Select: [ §pparts | @ Boards

aFiter

Product category:  |General Purpase v | Seeedgrade: |1 =,

Femiy: yna-7000 v| rempgade: |c -

Padkege: dgst +|  sRevison: [AlRemaining =

Reset Al Fiters
Search: [, =
yoPn ok cmE2 one2 & Avsi

i Count Ravs = FIBFOR  Transcevers Transcelvers _Transceivers 106
[Bxcm00dgasat 434 140 20 106300 o o o 2w |

1 <ade || MNext> Firish Cancel

Add Sources ¢

4. New Project

Add Existing IP (optional)

-l

N

4% New Project
Add Constraints (optional)

= | specify or create constraint files for physical and timing constraints.

s 1 &
\

Pressthe = button to Add Files or Create File

Copy constraints files into praject

f Newproject $
/ New Project Summary

VI\/Q\I[:)O'

(DA new RITL project named ‘roject_1' wil be created.

1 No source fles or drectories wil be added. ise Add Sources to add them later.
1 No Configurable TP fies villbe added. Use Add Sources to add them later.

1 No constrains fies vil be addied, Use Add Sources to add them later.

efauit part and product fami for the new project:

Padkage: dgag4
Speed Grade: -1

L

To Greate the project, cick Finsh

% = =

=1 =1




Gestion del archivo de restricciones

» Las restricciones son un conjunto de archivos
XDC

— Un proyecto puede tener mas de un conjunto de
restricciones

— Para ello, el conjunto a utilizar debe configurarse a
“activo” ("active®)

* Eso se hace presionando el boton derecho y
seleccionando la opcion “Make Active”

> Archivo XDC activo
— Es el archivo XDC de un conjunto de restricciones al
cual se le van a agregar nuevas restricciones

* Por ejemplo desde el asistente para restricciones
(Constraints Wizard)
— El archivo XDC activo se especifica con el boton
derecho y seleccionando “Set As Target Constraint
File”

| Sources =

‘-‘L‘ Tl pin
pag 3 |

= gt B E

Messages: (1) 7 warnings

| | B+ Design Sources (2)

[+ Verilog Header (1)
: a2 wave gen [wave gen.v) (14)
== Constraints {1)
: B constrs_1
--El wave_gen_timing.xdc (target)
L..HY wave_gen_pins.xdc
[ Simulation Sources (1)

M

i-lierarchv: IP Sources | Libraries | Compile Order |

: .g.”.g,_Snuru:E :m , _T_Er_n_pﬁai:es i



Navegador del proyecto (Project Navigator)

> Se utiliza para gestionar los archivos fuente,
configurar la IP y ver los detalles del proyecto

» Permite pasar por las distintas etapas del ciclo

Fle Edt Flow Took Window Layout View Help Q- Search commands
de desarrollo y aplicar las distintas ACBoREX S b Y EKEGEm T HONE
azxs Sources —ouwx Z Project Summary X | /1 ivadoLog X | ] vivado Journal X | @ yuart fed.v x| 4 b B O 12 X

ATE B | =

herramientas

e _ | %| eroject settings -
SRTE T | (5 vesin sources (1) =
5 Project Settings & los (yuart led v) (4) Project name: labs
% add sources B meta_harden_rst_io - meta_harden (mera_harden. vy Product famity:  2yng-7000
48 meta_harden_btn_i0 - meta_harden (meta_harden,v) Project part XCTZ0Z0CIn454-1
L 1P Catalog -t e (uart 1013
H L4 H H d_cH 0~ led o (=c_ct v) Topamoskie name-jos
> Visor de codigo rtuente (sources view v o | e
. nthesis & | Implementation
3 Create Block Design canstrs_1 (1) £l Ll
3 w8 uart_led. xde (target)
Open Block Desian G Stahus: +/ Complete Status:  Complete
.y . . . . 8 Generate Block Design Wessages: (1) 6 warnings Messages: No errors or warnii
— Presentacion jerarquica de codigo fuente, incluyendo e
) 4 Simulation Strategy: Vivado Svrthesis Defaults Strateqy: yivads Implements
5 Simulation Settings

Incremental Compile: None

los archivos de restricciones i

4 sources | 7 Templates
4 RTL Anslysis e ssbadl

+ & Open Elsborated Design | | 5euree Fil Properties - O x

[— i i 1 4 synth Summery: @ 0 arrors Worst Negative Slack (WHS): 0,293 ns
ISta ae liprerias e e B oo o,

[Summary | Route status |

DRC Violations % | Timing - Post-Implementation

Total Negative Slack (TNS):  Dns

| = 5 10 warmings .
> run symihess Location:  Cifsup/Fpaa_flowlabs/labSlabS.sres/censtrs_tfnew ‘—— sy of Fafioa Enceomts: 0

Qoiales Total Number of Endpoints; 105
[g¥ Open Synthesized Design ||| TvPe: xDC

. . . . . ]
* HDL y netlists, incluyendo referencias a librerias y i

Post-Synthesis . Post-Implemen
Copied to: C:Jxupifga_flow/labsflabSlab.srcsfconstrs._tfnew = <

H 1A H 4 Program and Debug
ubicacion en disco G| P 0 T T :

5 Power
Encrypted: Mo
% Gererate Distrean w

» Resumen del Proyecto (Project Summary) — e

5| Processing options
| Creating bitnap.

— Muestra la utilizaciéon del dispositivo, temporizaciéon y e

INFO: [Vivado 12-1942] Bitgen Completed Suscessfully.

| INFO: [Project 1-118] WebTalk data collection is enshled (User setting is ON. Install Setring is ON.).

. .y . ~ 1FO: (Cownon 17-83] Releasing license: Iuplementation
emas intformacion e 1ISeno |vrite bitstreas: Time is): cou - 000035 ; elapsed - OB:00:35 . Memory D) pesk - 017.005 ; gain - 353.330 =

] )
Syrithesis | Implement:

n | Simulation

158 Tel Consale | © Messages . B Log | 5 Reparts | 3 Design Runs |

» Consola Tcl:

— Mesajes de Compilacion, Reportes, y Ejecucion



Configuracion de un Proyecto

r' Project Settings . - | = 1
» Configuraciéon General: 9y | General
. . iy | 4 Mame:; project_1
- SeleCCIOnar dISpOSItIVO - ETE_!EI j Project device: é@xc?‘zﬂlﬂdg%‘%—l(acﬁve) E]
— Seleccionar lenguaje HDL S@; Beriaiae. [voteo 4
. . . ., T Defaultibrary: | xi_defaultib
— Elegir herramienta de simulacion ) L =
(normalmente Vivado Simulator) E'be g e |
_ Nombre del Top Module Snithesis Verilog options: | verilog_version=Verilog 2001 S
Generics/Parameters
— Opciones especificas del lenguaje wtm e [ 1000/ |
hdl ¥
gits%i]m
» Cada modulo tiene sus P
propias opciones de
configuracién
[ oc [ concel | aopv |
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Navegador de Ciclo de Desarrollo (Flow Navigator) para
proyectos RTL (RTL Projects)

» Configurar los archivos fuente del proyecto ;L«jm:r_rjaigamr «
— Agregar archivos fuente HDL , archivos de restricciones, archivos de e
simulacion y bloques logicos predefinidos (Intellectual Property — IP) . St Mannger

% Project Settings

> Integrar IP (IP Integrator) ¥ Add Sources
. , . - '/ Language Templates
— Crear, abrir o generar un bloque légico predefinido (IP) 5 1 Catiiog
3> Ejecutar una simulacion (Run Simulation) 4 TP Integrator

/& Create Block Design

— Se utiliza el simulador XSIM =
§¥ Cpen Block Design

— Se pueden realizar simulaciones de comportamiento (Behavioral), post- % Generate Block Design
synthesis (estimacion de tiempos), y post-implementation (temporizacion i S
real del SiStema) % simulation Settings
e w . () Run Simulation
> Analisis RTL (RTL Analysis)
. ] - . ] 4 RTL Analysis
— Abrir un disefio elaborado (Open Elaborated Design) y configurar las #3 Elaboration Settings

opciones de analisis " [* Open Elaborated Design
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Navegador de Ciclo de Desarrollo (Flow Navigator) para
proyectos RTL (RTL Projects)

. . . . . I i
> Ejecutar la herramienta de sintesis (Run Synthesis) F"";;t g
— Se busca cumplir los requerimientos de temporizacion [T
— Para cargar una netlist ya sintetizada: Open Synthesized Design button P Integrator
> Ejecutar la herramienta de implementacion (Run Implementation) RSl
. . .y s x . oy RTL Analysi
— Realiza la ubicacién fisica en el dispositivo y el ruteo. i
. . . 4 Synthesis
— Para cargar un sistema ya implementado: Open Implemented Design 5 Synthesis Settings
g y Y Y g g
. . . ., Run Synthesis
> Ejecutar las herramientas de configuracion de la FPGA y » &% Open Synthesized Design
depuraCién 4 Implementation
. e . . ., % Implementation Settings
— Generate Bitstream se utiliza para generar el archivo de configuracion de la T
FPGA b % Open Implemented Design

4 Program and Debug

— Hardware Manager se utiliza para configurar la FPGA; tambien incluye 8 i
herramientas para la depuracién del sistema ¥ Generate Bitstream

I @* Open Hardware Manager



Simulacion

> El simulador incluido (XSIM) permite simulaciones RTL, de netlist, y de

temporizacién

4 Simulation
@; Simulation Setkings
QLI__IQ Run Simulation

Run Behavioral Simulation

4 RTL Analysis
3 Run Post-Svnthesis Functional Simulation
» @ Open El
Run Post-Synthesis Timing Simulation

4 ASynthesis

@ Synthe:

Run Post-Implementation Functional Simulation

Run Post-Implementation Timing Simalation

& Run Synthesis

¢ labl - [Cu/xup/fpga flow/2016_2 ZYNQ labs/zed/lab1/labLxpr] - Vivado 2016.2

Fle Edt Fow Took Window Llayout Vew Run Hep =
Sy X 9 P %S XK L B |Soefaultlayout B & 2 TNl 500fns v W3 [l @ | & write_bitstream Complete
Flaw Navigatar 2 «| | Behavioral Simulation - Functional -sim_1-lab1 th X
Q=% Stopes _ O X Objects owx B Untitled 1 x O @ x
A @eHc@edwa GBI i 161 B B
4 Project Manager ).
@ Prosect settngs [Name =  Design Urit Block Type Name value Data Ty
o CRCTET TN T | | tiowosol =
| oSk Izb1 ) % leds[7:0] fd Array
¥ Language Templates bl Verilog Module (-2 e_led[7:0] fd Array
1F P catalog [ 2i[31:0] 25 Array
4 P Integrator
F Create Block Design
# Open Block Des
Generate Block Design
4 Simulation
&% simulation Settings
(il Run Simulation
4 RTL Analysis
5 Elaboration Settings
> g% Open Elaborated Design
4 Synthesis
&% Synthesis Settings
& Run Synthesis
> B
{5 Open Synthesized Design 2 Scope | & Sorees : o ¥
4 Implementation Td Console K] [ e
&% Implementation Settings Co run 500 ns -
[» Run Implementation = Iun, S00i5)
Z . o run 500 na
> @ Open Implemented Design o g
a run 500 ns =
4 Program and Debug & =
&% Bitstream Settings E] =
@ < i v
%) Generate Bitstream Im — —
f Type a Tcl comnand here

f% Open Hardware Manager

3 Td Console

Configure synthesis, smuiation, implementation and IP related options

© Messages | [ Log

Sim Time: 11700 ns
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Agregado de archivos de pruebas (Testbench)

> Los archivos de pruebas (*.V or *.VHD) se agregan

- - — -— - w

en forma separada de los archivos de descripcién o Ao sourceily
= Add Sources
H DL‘ del SIStema . VlVADO‘ I s cuides you through the process of adding and creating sou-ces for your project
— En “Flow Navigator”, seleccionar Add Sources () Add o create constrairts
. . . _' Add o create design sources
— Seleccionar Add or Create Simulation Sources y despues T —
“Next” -.:_.-A-:ld o° create D5P scurces
. . . () Add existing block design sources
— Presionar el simbolo "+" verde, y agregar archivos o rg— : Y
directorios si el archivo de pruebas ya existe; o Create File e e o s e o i o, G e is
para crear un nuevo archivo de prueba e -
. . . . . 4 Index Mame  Ubrary Lacation
— Seleccionar el tipo de archivo :Verilog, Verilog Header, LT85 iy i Gl ot o3 P sascmin
:

SystemVerilog, o VHDL

— Navegar y seleccionar el archivo existente o ingresar el
nombre de archivo para uno nuevo — e

[7] Sean and add RTL indude files into project

urces from si s
[#] Include all design sgurces for simulation

2 < Back Next > Finish ] | cancel




Configuracion de la Simulacién

#- Project Settings

» Permite seleccionar opciones especificas de

) . Simulation
Ia compIIaCIon y SImUIaCIon G%I Target simulator: Vivado Simulator ha
— Desde Flow Navigator, seleccionar Simulation @, Smetor enasage: vertes ’
Simulation set: i sim_1 hJ
H Simulation -
Settlngs | B %} Simulation top module name: | test_uart_rx E]

Clean up simulation files

— El top module de la simulacion es el archivo de
pruebas (testbench) especificado

m
o
(=3
=}
=
ol
-
=
3

-V

["] Generate scripts anly

Synthesis
— Se pueden ag regar OpC'OneS ad|C|Ona|eS Qompilation"'__glaboration."§imulati0n [ etlist | Advanced
- Opciones de compilacion en Compilation e (== (=)
i‘o?‘l Generics/Parameters options: E]
» Opciones de simulacion en Simulation Bitstream e p——— p—
. e . ., i}: xsim.compile.xvlog.relax
> Hay una guia especifica para simulacioén: , et
- - . . - - xsim.compile.xvhdl.more_options
Vivado Design Suite Simulation Guide i i

Select an option above to see a description of it

(UG900)

[ ’ Cancel Apply
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Resultados de |la Simulacion

» Graficos con las formas de onda

3 Se pueden agregar marcadores, medir tiempos y realizar ampliaciones para ver
intervalos de tiempo menores

Los Buses se pueden expandir a sus senales individuales
Se pueden crear grupos de senales relacionadas mediante divisores (Dividers)

Hay una Consola que muestra mensajes de salida de la simulacion

VvV ¥ V¥V V¥

Si no se configura otra cosa, se ven las senales declaradas en el top module
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Despues del proceso de Elaboracion (Elaboration Process)

vV ¥V ¥V V¥V V¥

Los fuentes, RTL Netlists, y restricciones estan disponibles
Se puede acceder a las propiedades de los items

Se generan reportes DRC

Esta disponible una vista esquematica RTL

Las vistas se pueden seleccionar por objetivos
— Clock Planning

4 RTL Analysis

13 Elaboration Settings
4 % Open Elaborated Design
@ Report DRC
Report Noise
1 schematic

|/O P| . clk_pin [ meta_harden_rst_i0
- +
anning Cgk_dstl
i rst_dsb signal_dst eta_harden_btn_i0
— Floorplannin : Meka_harderbin |
p g rst_pin D signal_src
meta_harden clk_dst
k. rst_dst signal_dst led ctl i0
btl‘lJ}iI‘l D signal_src
meta_harden btn_clk_rx
clk_rx
rst_clk_rx
Uart_r)(_i[] rx_data[7:0]
rx_data_rdy
clk_rx| rx_data[7:0] led ctl
rst_clk_rx rx_data_rdy -
xd_pin[_> xd J

uart_rx

led_of7:0] [ led_pins[7:0]
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Despues del proceso de Sintesis (Synthesis Process)

» El Flow Navigator permite acceder a: |euoumthest 5 Debug -

— Constraints Wizard,

— Edit Timing Constraints,
— Set Up Debug,

— Report Timing Summary,

& Run Synthesis
4 Synthesized Design

e} :
%, Constraints Wizard = Clock Flanning

g
i

0

_ Report Clock Networks, £4, Edit Timing Constraints £S Floorplanning ;m e
— Report Clock Interaction, £ Set Up Debug E‘mm.g
— Report DRC, (% Report Timing Summary 2= Timing Analysis If-‘om "
— Report Noise, . Report Clock Networks =
— Report Utilization, 4 Report Clock Interaction i
— Report Power, @ Repart DRC E‘mm =
— and Schematic utilities FT Report Noise 'f:m -
. . . ' [E Report Utilizati B
> Esta disponible la vista esquematica, A -
incluyendo buffers de entrada/salida T sehemme = BT
- - ﬂ‘ﬂ IBL -LH z‘_FUBJFOLJm
» Las vistas se pueden seleccionar por _Qm S '—Hﬁg | &
objetivo: wo————F ] : T e
—1/0O Planning, Clock Planning, Floorplanning, o e —
Debug, Timing Analysis e

» Toda la informacién de temporizacion es estimativa
hasta que el sistema este totalmente implementado



Despues del proceso de Implementacion (Implementation

Process
» Las pestanas de Fuentes y Netlist no cambian e o
— Cuando se selecciona un recurso en la pestafia Netlist, se % Implementation Settings
muestra su ubicacion fisica en el dispositivo en la vista [» Run Implementation
Device view 4 Implemented Design
— Cuando se selecciona un ruteo, la ubicacion de la l6gica y su iy Constraints Wizard
conexionado se muestra en la vista Device view £ Edit Timing Constraints
— Esto permite realizar un analisis de temporizacion y reubicar  [ELE AL @ Report Timing Summary
o rerutear recursos que no cumplen sus requisitos de gl Eﬁ :Ermrt Clock Net\'mrk.iﬂ
temporizacion E e ‘| Report Clock Interaction
. . S 1S Timing Analysis @ SEL DL
» Las vistas se seleccionan por objetivos PR Resport Noise
—1/O Planning, Clock Planning, Floorplanning, Timing Analysis | Report Utilization
» Se puede acceder al asistente de restricciones Wl Heport Bower

(Constraints Wizard)

» Los resultados de temporizacidén estan en el reporte
Timing Summary



o Caracteristicas del Entorno de Desarrollo Vivado

; Ciclo de Desarrollo

Contenido )
o Elementos del Entorno de Desarrollo Vivado

o Resumen



Resumen

» Caracteristicas del entorno de desarrollo

— Se puede estimar el desempefio del disefio desde las primeras etapas
— Los distintos reportes permiten verificar el cumplimiento de las restricciones de temporizacion
—La consola Tcl permite automatizar tareas mediante scripting

> Todas las herramientas utilizan el mismo modelo de datos a lo largo del proceso de
desarrollo
— Esto unifica los procesos de sintesis e implementacion

> El desarrollo puede ser mediante scripting (cuando no esta basado en un proyecto) y puede
ser basado en un proyecto, utilizando mayoritariamente la intefase grafica

— Todos los comandos estan disponibles a traves de la consola Tcl

» Las restricciones se describen en un unico lenguaje (common constraint language — XDC)
durante todo el desarrollo
— Esto permite unificar las restricciones de sintesis y de implementacion

» Para la mayoria de los disenos, las herramientas se invocan desde la interfase grafica
(mediante botones)

» Hay disponibles herramientas, configuraciones avanzadas y scripting para desarrollos
complejos



